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更にサンプル コードをお求めでしょうか？以下の通りご対応いたします。 

PSoC のサンプルコードのリストにアクセスするには、サンプル コードのウェブページをご覧ください。

PSoC 4のビデオ ライブラリについてはここからご覧ください。 

本アプリケーション ノート (AN73503) では、USB ヒューマン インターフェース デバイス (HID) クラスを使用して PsoC 

デバイス用に USB ブートローダを実装する方法について説明します。また、Windows ベースの USB ブートローダのホスト  

プログラムをビルドする方法も説明します。  
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1 はじめに 

ブートローダは MCU システム設計で一般的に使用されます。ブートローダにより、製品のファームウェアを現場で更新する 

ことができます。工場では、製品への初期ファームウェア プログラミングは一般的に MCUの Joint Test Action Group (JTAG) 

または Serial Wire Debugger (SWD) のインターフェースを介して実行されます。しかし、これらのインターフェースは通常、

現場では利用できません。 

そこでブートローディングを活用します。ブートローディングは USB や I
2
C などの標準通信インターフェースを経由してシステム 

ファームウェアのアップグレードを可能にします。ブートローダはホストと通信し、新しいアプリケーション コードやデータを取得

し、デバイスのフラッシュ メモリに書き込みます。 

本アプリケーション ノートでは以下の項目の方法について説明します: 

http://www.cypress.com/
http://www.cypress.com/documentation/code-examples/psoc-345-code-examples
http://www.cypress.com/video-library/PSoC
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 PSoC 3、PSoC 4 Lシリーズ、または PSoC 5LPデバイスに USBブートローダを追加 

 ブートローディング用にアプリケーション プロジェクトを準備 

 PSoC Creatorと共に提供されるブートローダ ホスト プログラムを使用 

 ユーザー独自のWindowsベースのブートローダ ホスト プログラムを作成 

本アプリケーション ノートは PSoC および PSoC Creator IDE の経験者を対象としています。PSoC の初心者である場合、

AN54181、AN79953、および AN77759の PSoC入門アプリケーション ノートをご参照ください。PSoC Creatorが初めての

方は、PSoC Creatorホームページをご参照ください。 

本アプリケーション ノートは、読者がブートローダの概念を理解していることも想定しています。これらの概念をご存知ない 

場合、「AN73854, PSoC Introduction to Bootloaders」のアプリケーション ノートをご参照ください。 

最後に、本アプリケーション ノートは読者が USBに慣れていることを想定しています。USBまたは USB HIDクラスが初めて

であれば、「AN57294 - USB 101: An Introduction to Universal Serial Bus 2.0」または「AN57473 - USB HID Basics with 

PSoC」のアプリケーション ノートをご参照ください。 

1.1 用語および定義 

図 1に示す通り、製品に組み込まれたファームウェアは通常動作とアプリケーション更新という 2つの異なる目的で通信ポートを

使用することを示します。アプリケーションを更新する組み込みファームウェアの部分はブートローダと呼ばれています。 

図 1. ブートローダ システムのブロック図 

Target

MCU

Flash 

Memory

Bootloader

Application

HostCommunication

Channel

Application 

File

 

一般に、フラッシュを更新するデータを提供するシステムは ホスト、更新されるシステムはターゲットと呼ばれます。ホストは 

外部の PCまたはターゲットと同じ PCBにある別のMCUです。 

ホストからターゲットのフラッシュにデータを転送する動作はブートローディング、ブートロード動作、または単にブートロードと

呼ばれます。フラッシュに配置されるデータはアプリケーションまたはブートローダブルと呼ばれます。 

ブートローディングのもう 1つの用語はインシステム プログラミング(ISP) です。サイプレスには似た名前の In-System Serial 

Programmer (インシステム シリアル プログラマ) (ISSP) と呼ばれる製品、および Host-Sourced Serial Programming  

(ホストソース シリアル プログラミング) (HSSP) と呼ばれるオペレーションがあります。詳細については、アプリケーション ノート

AN73054または「AN84858, PSoC Programming Using an External Microcontroller (HSSP) 」をご参照ください。 

1.2 ブートローダの使用 

ブートローダの通信ポートは通常、ブートローダとアプリケーション間で共有されます。ブートローダを使用するための最初の
ステップは、アプリケーションではなくブートローダが実行されるように製品を操作することです。  

ブートローダが実行されると、ホストは通信チャネルを経由して「ブートロード開始」コマンドを送信できます。もし、ターゲットから
「OK」の応答が送信されると、ブートローディングは開始できます。 

http://www.cypress.com/
http://www.cypress.com/?rID=39157
http://www.cypress.com/?rID=39157
http://www.cypress.com/?rID=60890
http://www.cypress.com/go/creator
http://www.cypress.com/?rID=56014
http://www.cypress.com/?rID=39327
http://www.cypress.com/index.cfm?rID=39404
http://www.cypress.com/index.cfm?rID=39404
http://www.cypress.com/?rID=57435
http://www.cypress.com/documentation/application-notes/an84858-psoc-4-programming-using-external-microcontroller-hssp


 

PSoC
®
 USB HIDブートローダ 

www.cypress.com 文書番号: 002-11097 Rev. *A 3 

ブートローディング中、ホストは新しいアプリケーション用のファイルを読み出し、フラッシュ書き込みコマンドにそれを変換し、

それらのコマンドをブートローダに送信します。ファイル全体が送信された後、ブートローダは新しいアプリケーションに制御を

渡すことができます。 

1.3 ブートローダの機能フロー 

ブートローダは通常、リセット時に最初に実行されます。

図 2に示すように、次の動作が実行できます。 

 アプリケーションを実行させる前にその妥当性を

チェック 

 ホストとの通信を開始するタイミングを管理 

 ブートロード／フラッシュの更新動作を実行 

 最後に、アプリケーションに制御を渡す 

1.4 USBブートローダに関する注意事項 

ブートローダ通信インターフェースとして USB ポートを

使用する際、考慮すべきいくつかの項目があります。

USB HID クラスでは、ドライバーを必要とせずに、 

デバイスがあらゆるホスト オペレーティング システム

で動作できるという利点があります。 

ブートローダがアプリケーションに制御を渡す前に 

限られた時間待機し、USBデバイスが列挙するために

時間が掛かることに留意してください。もし、USB 

列挙に時間が掛かり過ぎると、ホストはターゲット  

デバイスがリセットした後にブートロード動作を開始

するチャンスを逃すことがあります。 

アプリケーションに制御が渡された後に、ブートローダ
に制御を戻すいくつかの方法があります。 

 ブートローダブル API 

PSoC Creatorのブートローダブル コンポーネントは、

ブ ー ト ロ ー ダ を 開始 す る ための API 関数 

(Bootloadable_Load()) を備えています。これにより

アプリケーションがブートローダに制御権を渡し返す

ことができます。これは製品を使用するユーザーが 

ファームウェアの更新を開始することができる良い 

方法です。 

この方法の問題はアプリケーションの更新を実行する

ことが、アプリケーション コードに依存することです。 

もし、アプリケーションにブートローダの転送ができない

バグがあった場合、それはどうなりますか？ファーム

ウェアをアップグレードおよび修正する能力を確保する

には、ブートローダ プロジェクトにブートローダを起動

するフェイルセーフ手法を置くべきです。 

図 2. ブートロード処理のフローチャート 
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 起動時に無限の待機時間でブートローダの起動 

USB ブートローダで破損したアプリケーションや長い USB 列挙時間などの問題に対処するために、ホスト コマンドが受信さ
れるまでブートローダに留まる方法を追加することができます。Bootloader_Start() を呼び出して通常のルーチンを実行する
前に、いくつかのユーザー入力を確認するようにブートローダ プロジェクトをカスタマイズすることができます。 

詳細については、ブートローダ ファームウェアセクションをご参照ください。 

http://www.cypress.com/
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1.5 サンプル コード 

次のセクションは、PSoC Creator ブートローダとブートローダブル プロジェクトの作成手順を説明します。サンプル コード

CE95391を利用すれば完全なプロジェクトを入手できます。 

2 ブートローダ プロジェクト 

PSoCブートローダ システムには最低 2個の PSoC Creatorプロジェクト- 1つ目はブートローダ プロジェクトで、残りは少な

くとも 1個のブートローダブル (アプリケーション) プロジェクトが含まれています。本セクションはブートローダ プロジェクトの作

成方法について説明します。次のセクションはブートローダブル プロジェクトの作成方法について説明します。 

ブートローダ プロジェクト デザインは図 3に示すように、PSoC Creatorブートローダおよび USBFSコンポーネントを含みます。

USBFS コンポーネントは PC ホストと通信して、コマンドおよび新しいアプリケーション イメージを取得します。ブートローダ  

コンポーネントはフラッシュ プログラミング、ホスト コマンド／応答プロトコルを行い、ブートローダブル アプリケーションを起動

します。 

2.1 プロジェクトの作成 

開始するには、新しい PSoC Creatorプロジェクトを作成します。Create Projectダイアログからターゲットのハードウェアやデ

バイスを選択します。 

ワークスペースを「PSoCx_USB_Bootloader」などの名前にします。プロジェクトを「USB _Bootloader」などの名前にします。 

次に、PSoC Creatorコンポーネント – USBFS、ブートローダ、および他のコンポーネント – を回路図に追加します。図 3に示す通

り、コンポーネントの名前を変更することもできます。 

図 3. サンプル コード CE95391のブートローダ プロジェクトの回路図 

 

http://www.cypress.com/
http://www.cypress.com/documentation/code-examples/ce95391-psocr-usb-hid-bootloader
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2.2 ブートローダ コンポーネントの設定 

図 4 に示すように、ブートローダ コンポーネントの必要となる変更は「Communication component」を USBFS にするだけの 

ことです。これはブートローダが USB とインターフェースするために必要な機能を生成するように PSoC Creatorに指示します。 

図 4. ブートローダ コンポーネントのカスタマイザ 

 

また、「Wait for command」の設定を確認することも必要です。USB デバイスの列挙時間を考慮する必要があるため、これらは

USBブートローダに特に重要です。 

 「Wait For Command」: デバイスのリセット時に、ブートローダはホストからコマンドが入力されるまで待機するか、または

直ちにアプリケーション コードにジャンプします。このオプションを選択すると、ブートローダはWait for command time

パラメーターで指定したタイムアウトまでホストからのコマンドを待機します。タイムアウト期間内にブートローダがホスト 

からコマンドを受信しない場合、アプリケーション コードにジャンプします。 

 「Wait for command time (ms)」: 上記のオプションが有効の場合、このパラメーターはブートローダがアプリケーション 

コードにジャンプする前の待機時間です。0 値は、「Wait forever (永久に待機)」と解釈されます。デフォルト値は 2 秒の 

タイムアウトです。 

デバイスのフラッシュに有効なアプリケーションがインストールされていない場合、ブートローダはこれらの設定を問わずに 

ホスト コマンドを永久に待機します。 

ブートローダ コンポーネントの完全な設定情報については、ブートローダ コンポーネント データシートをご参照ください。 

2.3 USB コンポーネントの設定 

次は、ブートローダ通信をサポートするために

USBFS コンポーネントを設定します。外部で提供さ

れるドライバー ファイルをホスト PC に必要としない

ように USB HIDクラスを使用します。 

ダブルク リックして、USBFSコンポーネントの設定を

始めます。そして、コンフィギュレーション ダイアログ

で、デフォルトの Device Descriptor ルートを削除し

ます。図 5に示すように、Device Descriptor タブを

クリックして、「X」ボタンをクリックします。 

図 5. デフォルトの USB設定の削除 

 

http://www.cypress.com/
http://www.cypress.com/?rID=71586
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図 6 に示すように、次に「Insert Configuration」オプションを使用して、ブートローダ用 USB 設定をインポートします。ブート 

ローダ用の完全な USB設定は.xmlファイルで保存され、PSoC Creatorに含まれます: 

<PSoC Creator InstallDir> \ psoc \ content \ cycomponentlibrary \ CyComponentLibrary.cylib \ USBFS_v_2_80 \ Custom \ 
template \ Bootloader.root.xml 

その設定がインポートされた後、PSoC Creator は自動的に必要な USB ディスクリプタのロードを開始します。USB 設定の 

詳細については、付録 Aをご参照ください。 

図 6. USBの Insert Configuration 

 

2.4 入力ピンの設定 

前述のように、ブートローダを起動するためにバックドア オプションを提供した方が良いです。これを行う 1 つの方法は、起動

時にピンの状態を確認することです。エンド アプリケーションにスイッチなどのユーザー インターフェースが既にあった場合に

有効な方法です。 

Digital Input Pinコンポーネントを使ってピンの状態を読み出します。サンプル コード CE95391ではピンがキットのボタンに接

続されます。ボタンは押された時、グランドに短絡するため、ピン コンポーネントをプルアップ抵抗 (Resistive pull up) に設定し

ます。そのため、ボタンを押した時に、ピン入力の状態が「0」になり、ボタンを離した時に、ピン入力の状態が「1」になります。 

2.5 ピンの配置およびクロックの設定 

全てのコンポーネントを設定した後、クロック リソースを設定し、ピンを配置します。 

ワークスペース エクスプローラ ウィンドウで USB_Bootloader.cydwrをダブルクリックします。Pin Selection タブが表示され

ます。Wait_Forever と他のピン コンポーネントを、ご使用のキットにあるデバイスの物理ピンに割り当てます。CE95391を例

としてご参照ください。 

注: PSoC Creatorによって、USB D+および D-データ ラインは自動的に割り当てられます。 

注: ブートローダ プロジェクトのピン コンポーネントとアプリケーションのピン コンポーネントを同じ物理ピンに割り当てること

が可能です。ブートローダとアプリケーションは独立したプロジェクトなので、同じピン名を使用することもできます。 

http://www.cypress.com/
http://www.cypress.com/documentation/code-examples/ce95391-psocr-usb-hid-bootloader
http://www.cypress.com/documentation/code-examples/ce95391-psocr-usb-hid-bootloader
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次は Clocks タブをクリックし、いずれかのクロックをダブルクリックし、クロック コンフィギュレーション ウィサードを開きます。

USB用にクロックを設定します (図 7は PSoC 4 Lシリーズの場合で、図 8は PSoC 3および PSoC 5LPの場合です)。 

図 7. PSoC 4 Lシリーズの USBクロックの設定 

  

図 8. PSoC 3および PSoC 5LPの USBクロックの設定 

 

http://www.cypress.com/
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2.6 ブートローダ ファームウェア 

プロジェクトのすべてのコンポーネントを設定した後、ブートローダ動作を制御するためのファームウェアを追加します。 

(プロジェクトの Build > Generate Applicationを実行した後ファームウェアを追加することを推奨します。) 

多くの場合には、main.cに Bootloader_Start()のブートローダ コンポーネント API呼び出し関数を追加するだけで済み
ます。(呼び出し関数の「Bootloader」部分をご使用のブートローダ コンポーネントの名前 (デフォルトの値から変更済みの場
合) に置き換えます。) 

Bootloader_Start()関数はすべてのブートロード機能を担当します。戻り値はなく、アプリケーションに制御権を渡す前に、
PSoCデバイスをリセットします。ブートローダとデバイスのリセットの詳細については、付録 Bをご覧ください。 

図 3 に示すブートローダ インジケータおよび制御ピンの使用方法についてより複雑な例については、サンプル  コード
CE95391をご参照ください。 

3 ブートローダブル (アプリケーション) プロジェクト 

ブートローダブル プロジェクトは図 9 に示すように、PSoC Creator ブートローダブル コンポーネントを含みます。他のコン 

ポーネントは希望アプリケーションを実装します。 

サンプル コード CE95391には、キットの LEDを異なる周波数で点滅させる 2個のブートローダブル プロジェクトがあります。
また、プロジェクトはキットのボタン スイッチも読み出します。スイッチが閉じると、プロジェクトは制御権をブートローダに転送します。 

図 9. ブートローダブル プロジェクトの回路図 

 

3.1 プロジェクトの作成 

新しい PSoC Creator プロジェクトを作成します。ターゲットのハードウェアやデバイスをブートローダ プロジェクトと同様に選
択します。プロジェクトを「USB _Bootloadable」などの名前にします。ブートローダ プロジェクトのワークスペースに追加する
か異なるワークスペースに保存することができます。1

 

次に、PSoC Creatorコンポーネント – ブートローダブルおよび他のコンポーネント – を回路図に追加します。図 9に示す通り、
コンポーネントの名前を変更することもできます。 

                                            
1
 1つの PSoC Creatorのワークスペースは複数のプロジェクトを持つことができます。多くの場合、ブートローダ プロジェクトはその関連する

ブートローダブルと同じワークスペースに存在します。しかし、そのようにする必要はありません—ブートローダとブートローダブルは別のワー

クスペースや、PC 上の別の場所に存在することができます。PSoC を始める前に、全体的なシステムの開発ニーズのために、ワークスペー

ス／プロジェクト計画を考えておくことをお勧めします。 

http://www.cypress.com/
http://www.cypress.com/documentation/code-examples/ce95391-psocr-usb-hid-bootloader
http://www.cypress.com/documentation/code-examples/ce95391-psocr-usb-hid-bootloader
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3.2 ブートローダブル コンポーネントの設定 

図 10に示すように、ブートローダブル プロジェクトは常に関連ブートローダ プロジェクトの出力「.hex」および「.elf」ファイルに

依存します。「.hex」ファイルを選択すると、関連の「.elf」ファイルが自動的に選択されます。 

ブートローダブル コンポーネントを構成する前に、関連のブートローダ プロジェクトを完全にビルドする必要があります。 

図 10 に、ブートローダ「.hex」ファイルが PSoC Creator ワークスペース内の相対パスにあることを示します。ただし、これは

必須ではありません。ブートローダおよびブートローダブル プロジェクトは異なるワークスペースにあっても構いません。どちら

の場合にも、ブートローダ プロジェクトのコンパイラ出力のためのフォルダ内に.hexファイルがあります。 

<project folder>\USB_Bootloader.cydsn\DP8051\DP8051_Keil_903\Debug\ (PSoC 3の場合) 

<project folder>\USB_Bootloader.cydsn\CortexM3\ARM_GCC_493\Debug\ (PSoC 4 Lシリーズと PSoC 5LPの場合) 

ブートローダおよびブートローダブル ファイルの詳細については、「AN73854 - PSoC Introduction to Bootloaders」をご参照

ください。 

図 10 ブートローダブル コンポーネントの設定 

 

3.3 プロジェクトの残り部分の設定 

ブートローダブル コンポーネントが設定された後、ブートローダブル プロジェクトの残り部分を、標準の (非ブートローダブル) 

プロジェクトと同様な方法でビルドできます。他のコンポーネントを必要に応じて回路図に追加し、設定してからファームウェア

を追加します。サンプル コード CE95391を例としてご参照ください。 

ブートローダブル プロジェクトを複数作成し、それぞれを以前作成したブートローダ プロジェクトと結合させることができます。

ブートローダ プロジェクトがターゲットのハードウェアにインストールされた後、異なるブートローダブル プロジェクトをダウン 

ロードすることでターゲットの機能を変更できます。 

これより以降の本アプリケーション ノートでは、PSoC Creator と共に提供されるブートローダ ホスト プログラムの使用法、 

および PCベースのブートローダ ホストのビルド方法について説明します。 

http://www.cypress.com/
http://www.cypress.com/documentation/application-notes/an73854-psoc-3-psoc-4-and-psoc-5lp-introduction-bootloaders
http://www.cypress.com/documentation/code-examples/ce95391-psocr-usb-hid-bootloader
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4 PSoC Creatorのブートローダ ホスト 

PSoC Creatorは、ブートローダおよびブートローダブル プロジェクトの使用を容易にするためにブートローダ ホスト プログラムを

提供します。以下の手順に従って行ってください: 

1. ブートローダ プロジェクトをビルドして、ターゲットとなる PSoCにプログラムします。 

2. ブートローダ ホスト ツールを開きます (図 11)。PSoC Creator メニューから Tools > Bootloader Hostを選択します。 

図 11. PSoC Creatorのブートローダ ホスト プログラム 

 

3. 図 12 に示す通り、Filters をクリックし、ブート 

ロードしようとする USB デバイス (ご使用の

PSoCターゲット) を識別するためにフィルターを

追加します。 

ベンダ ID (VID) および製品 ID (PID) がブート

ローダ コンポーネントの設定に定義されている

ものと一致することを確かめてください。 

4. Open File アイコンをクリックし、ブートローダブル 

ファイルを参照します。ファイルは .cyacd の 

形式で、ブートローダブル  プロジェクトの 

コンパイラ出力用のフォルダにあります。 

ブートローダおよびブートローダブル ファイルの

詳 細 に つ い て は 、 「 AN73854 - PSoC 

Introduction to Bootloaders」をご参照ください。 

5. ブートロードを開始するために Program を 

クリックするか、または F5キーを押します。 

図 12. USBフィルターの設定 

 

ブートロード処理が完了した後、既定のタイムアウト期間が経過したら、制御権はブートローダからブートローダブル アプリ 

ケーションに渡されます。 

http://www.cypress.com/
http://www.cypress.com/documentation/application-notes/an73854-psoc-3-psoc-4-and-psoc-5lp-introduction-bootloaders
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5 ブートローダ ホストのビルド 

本節に、カスタムの USBブートローダ ホストを実装するWindows用のグラフィカル ユーザー インターフェース (GUI) アプリ

ケーションの作成法について説明します。ここでは重要なステップのみ説明します。Windows のアプリケーション開発または

Microsoft Visual Studioのご経験がない方は、関連リソース節をご参照ください。 

ご参考のために、完全なブートローダ ホスト アプリケーションの Visual Studioプロジェクト - USBBootloaderHost_VC2015.zipを

本アプリケーション ノートに添付しております。コードをプロジェクトのソース ファイルから開発中のプロジェクトにコピー&ペースト 

することも可能です。 

5.1 必要なリソース 

ブートローダ ホストを作成するには以下のものが必要です: 

 Visual Studio 

Visual Studio版は、様々な開発ツールを提供し、C#や C++などのプログラミング言語に対応しています。 

本アプリケーション ノートにある説明は Visual Studio Community 2015用であることに、ご注意ください。別のバージョンの

Visual Studioは異なる手順を必要とすることがあります。 

 Visual C# Express 2015 

これは、C#プログラミング言語を使って.NET アプリケーションを開発するための Microsoft 社の無償の IDE です。本アプリ 

ケーション ノート内の説明は無料版のものですが、完全版 (Visual Studio) を使用することもできます。 

 Visual C++ Express 2015 

これは、.NETアプリケーションを開発するための Microsoft社のもう 1つの IDEです。これは C++プログラミング言語を使用

します。本アプリケーション ノートでは、Visual C++ Expressは、Cモジュールを使用してダイナミック リンク ライブラリ (DLL) 

を生成するために使用されます。 

 CYUSB.dll 

CYUSB.dll は、Visual Studio アプリケーションをサイプレスの USB デバイスにインターフェースするためにサイプレスが開発し保

持する.NETダイナミック リンク ライブラリ (DLL) です。このDLLは、Visual Studio用のUSB開発ツールの完全なセットであるサ

イプレスの SuiteUSBパッケージとセットになっています。SuiteUSBをサイプレスのCypress SuiteUSBからダウンロードします。 

 PSoC Creator とともに提供されるブートローダ API 

ホスト プログラムの作成に使用される 4つの APIモジュールは PSoC Creatorの以下の場所にあります: 

<install folder> \ PSoC Creator \ 3.3 \ PSoC Creator \ cybootloaderutils. 

これらのモジュールは、サイプレスのブートローダ コマンド／応答プロトコルを使って、ホストが PSoC Creator ブートローダ  

コンポーネントとのインターフェースのために必要なコードをすべて含んでいます。このプロトコルの詳細についてはブートロー

ダ コンポーネント データシートまたはシステム リファレンス ガイドをご参照ください。 

4つのモジュールがあり、それぞれは一組の.c / .hファイルです: 

 cybtldr_api.c / .h 

このモジュールはブートロード動作の開始、フラッシュ行のプログラミング、行の消去、行の検証、およびブートロード動作

の終了を行う低レベル関数を含んでいます。 

 cybtldr_api2.c / .h 

このモジュールはブートロード プロセス全体を管理するより高いレベルの APIです。デバイスのプログラミング、デバイス

の消去、デバイスの検証およびブートロード動作の中止を行う関数を含んでいます。 

 cybtldr_command.c / .h 

このモジュールはブートローダに送信するコマンド パケットを構成し、ブートローダからの応答パケットを解析します。 

 cybtldr_parse.c / .h 

このモジュールはデバイスに送信するブートローダブル イメージを含む*.cyacdファイルを解析します。 

http://www.cypress.com/
https://www.visualstudio.com/en-us/products/visual-studio-express-vs.aspx
http://www.cypress.com/?rID=34870
http://www.cypress.com/?rID=71586
http://www.cypress.com/?rID=71586
http://www.cypress.com/?rID=51972
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5.2 ブートローダ ホスト アプリケーションの作成 

このプロセスは次の重要な段階があります: 

段階 1: PSoC Creatorとともに提供されるブートローダ ユーティリティ関数で DLL (ダイナミック リンク ライブラリ) を作成。  

段階 2: C# Windowsフォーム アプリケーション (すなわち、GUI) を作成。 

段階 3: 通信関数の定義 

段階 4: 段階 1で作成した DLLから必要なブートローダ関数をインポート 

段階 5: フォーム関数を修正 

段階 6: ホスト エラー コードを定義  

次の節では、それぞれの段階を詳細に説明します: 

5.2.1 段階 1: DLL の作成  

まず、PSoC Creatorのブートローダ Cファイルを含む DLLを作成します。詳細については、付録 C – ホスト コア APIをご参

照ください。 

1. Visual Studio Expressを起動します。 

2. C++ DLLプロジェクトを新規作成します。 

図 13に示すように、Win32コンソール アプリケーションを見るためにはWindows Desktop用の Visual C++ 2015ツールを

インストールする必要があることもあります。メニューから File > New > Project… > Visual C++ > Win32 Console 

Applicationを選択します。 

図 13. Windows Desktop用の Visual C++ 2015ツールをインストールします。 

 

3. プロジェクトに Bootloader_Utilsなどの適切な名前を付けます。OKをクリックして Nextをクリックします。 

4. Application type を DLL に、Additional options をエンプティ プロジェクトに設定します。Finish をクリックして、これらの 

設定を有効にし、新しいプロジェクトを作成します。 

5. ソリューション エクスプローラ ウィンドウで、プロジェクト名 (「Bootloader_Utils」) を右クリックして Add > Existing Item… 

を選択します。PSoC Creatorフォルダ <install folder> \ PSoC Creator \ 3.3 \ PSoC Creator \ cybootloaderutilsから

次のファイルを追加します: 

 cybtldr_api.h、cybtldr_api.c 

 cybtldr_api2.h、cybtldr_api2.c 

 cybtldr_parse.h、cybtldr_parse.c 

 cybtldr_command.h、cybtldr_command.c 

 cybtldr_utils.h 

6. プロジェクト名(「Bootloader_Utils」) を右クリックして、プロジェクト プロパティにプリプロセッサの定義を追加します。次の

メニュー項目を選択します: 

Project Properties > Configuration Properties > C/C++ > Preprocessor > Preprocessor Definitions > 
Edit… 

プリプロセッサ定義の末尾に「_CRT_SECURE_NO_WARNINGS」を挿入します。 

7. プロジェクトをコンパイル – Build > Build Solutionを選択します。これは Bootloader_Utils.dllファイルを作成します。 

http://www.cypress.com/
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5.2.2 段階 2: Windows フォーム  アプリケーションの作成  

次の段階はブートローダ ホストに GUIを作成します。GUIは Visual C#を使用して作成します。主な要件は次の通りです: 

 デバイスの VID と PID に基づいて認識し、HID デバイスに接続します。詳細については、関連リソースの USB アプリ 

ケーション ノートをご参照ください。 

 ユーザーがセキュリティ キーを入力する入力ボックスを配置します。 

 デバイス上にブートロードする新しい.cyacdファイルをユーザーが選択できるようにします。 

 .cyacdファイルをデバイスにプログラムします。 

 x86プラットフォーム ターゲット (Project Properties > Build = > Platform target > x86) を使用します。 

 いくつかのシステムには.NET Framework 4.x でビルドのエラーが発生する場合があるため、.NET Framework 3.5 を

使用してください。メニューの Project Properties > Application > Target framework > .NET Framework 3.5を選

択します。 

以下の手順に従って行ってください: 

1. Visual Studioを起動します。 

2. C#プロジェクトの新規作成します。次のメニュー項目を選択します: 

File > New > Project… > Visual C# > Windows Forms Application. 

3. プロジェクトに USBBootloaderHostなどの適切な名前を付け、OKをクリックします。 

4. そのフォームをデザインします。図 14に示すように、5つのラベル、5つのテキスト ボックス、2個のボタン、1個の進捗バー、

および 1個の openFileDialogをツールボックス からメイン フォームに配置します。適切な名前とデフォルト値を与えます。 

図 14. カスタム ブートローダ ホスト GUI 

 

label1.Text = “Vendor ID 0x” 

label2.Text = “Product ID 0x” 

label3.Text = “USB HID State” 

label4.Text = “Security Key(6bytes) 0x” 

label5.Text = “Status Log” 

textBox1.Text = “04B4” 

textBox2.Text = “B71D” 

textBox3.Text = “Disconnected” 

textBox3.ReadOnly = true 

textBox4.Text = “000000000000” 

textBox5.Text = “”, textBox5.Multiline = true 

textBox6.Text = “”, textBox6.ReadOnly = true 

http://www.cypress.com/
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5.2.3 段階 3: 通信関数の定義  

次の段階では、C#アプリケーションに CyUSB.dllから CyUSB関数をインポートします。CyUSB関数は.NETフレームワーク

により作成されていないためアンマネージ コードと見なされることにご注意ください。アンマネージ コードの詳細については、

Secure Coding Guidelines for Unmanaged Codeをご参照ください。 

関数をインポートするために、以下のステップに従ってください: 

1. CyUSB.dll をプロジェクト フォルダにコピーします。Cypress SuiteUSB がインストール済みの場合、CyUSB.dll の格納

場所は次の通りです: 

C:\Cypress\Cypress Suite USB 3.4.7\CyUSB.NET\lib. 

2. プロジェクト名や Referencesを右クリックして、CyUSB.dllを選びます: 

References > Add Reference… > Browse… > CyUSB.dll 

3. CyUSB.dllの前のチェックボックスにチェックを入れ OKをクリックします。 

4. 新しいクラス ファイルを追加します: プロジェクト名を右クリックして、Add > New Item… > Classを選択します。クラス ファイル

を Bootloader_Utils.csなどの適切な名前にします。 

5. 15 ページのコード 1 に示すように Bootloader_Utils.cs にコードを追加します。また、本アプリケーション ノートに添付される 

完全なブートローダ ホスト Visual Studioプロジェクト - USBBootloaderHost_VC2015.zipの Bootloader_Utils.csから

コードをコピー&ペーストすることもできます。 

5.2.4 段階 4: ブートローダ関数のインポート  

次の段階は、DLL からのブートローダ関数 (Bootloader_Utils.dll) を C#アプリケーションにインポートします。これは dllimport 

モディファイヤを使用して実現されます (コード 1を参照)。 

1. コード 1に示すように、コードを Bootloader_Utils.csに追加します。また、本アプリケーション ノートに添付される完全なブート

ローダ ホスト アプリケーション Visual Studioプロジェクト - USBBootloaderHost_VC2015.zipの Bootloader_Utils.csファイル

からコードをコピー&ペーストすることもできます。 

2. 段階 1で作成した BootLoader_Utils.dllをプロジェクト の出力フォルダ (: ..\bin\x86\Debug) にコピーします。 

5.2.5 段階 5: フォーム関数を修正  

いくつかのイベントとプロセスのコードがフォームに追加される必要があります。以下のようなものが挙げられます: 

 USB HID接続および通信の設定 

 ファイル管理 

 進捗表示 

本アプリケーション  ノートに添付される完全なブートローダ  ホスト  アプリケーション Visual Studio プロジェクト  - 

USBBootloaderHost_VC2015.zip の Form1.cs ファイルからコードをコピー&ペーストすることが一番簡単な方法です。その

後、コードを自分のアプリケーション用に修正できます。 

5.2.6 段階 6: ホスト  エラーコードを定義  

クラス ファイルを作成し、Bootloader_enum.cs などの適切な名前にします。enum の定義は cybtldr_utils.h ファイルのもの

と一致する必要があります。本アプリケーション ノートに添付される完全なブートローダ ホスト アプリケーション Visual Studio

プロジェクト - USBBootloaderHost_VC2015.zip の Bootloader_enum.cs ファイルからコードをコピー&ペーストすることが 

一番簡単な方法です。 

http://www.cypress.com/
https://msdn.microsoft.com/en-us/library/0e91td57(v=vs.110).aspx
http://www.cypress.com/?rID=34870
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コード 1. Bootloader_Utils.cs 

using System; 

using System.Collections.Generic; 

using System.Linq; 

using System.Text; 

using System.Runtime.InteropServices; 

 

namespace USBBootloaderHost  

{ 

    class Bootloader_Utils 

    { 

        // Communication control structure 

        [StructLayout(LayoutKind.Sequential)] 

        public struct CyBtldr_CommunicationsData 

        { 

            public OpenConnection_USB OpenConnection; 

            public CloseConnection_USB CloseConnection; 

            public ReadData_USB ReadData; 

            public WriteData_USB WriteData; 

            public uint MaxTransferSize; 

        }; 

         

        // Unmanaged code handling 

        [UnmanagedFunctionPointer(CallingConvention.Cdecl)] 

        public delegate int OpenConnection_USB(); 

         

        [UnmanagedFunctionPointer(CallingConvention.Cdecl)] 

        public delegate int CloseConnection_USB(); 

         

        [UnmanagedFunctionPointer(CallingConvention.Cdecl)] 

        public delegate int ReadData_USB(IntPtr buffer, int size); 

         

        [UnmanagedFunctionPointer(CallingConvention.Cdecl)] 

        public delegate int WriteData_USB(IntPtr buffer, int size); 

         

        // DLL importing 

        [UnmanagedFunctionPointer(CallingConvention.Cdecl)] 

        public delegate int CyBtldr_ProgressUpdate(byte arrayID, ushort rowNum); 

        [DllImport("BootLoader_Utils.dll", CallingConvention = 

                   CallingConvention.Cdecl)] 

        public static extern int CyBtldr_Program(string file, byte[] securityKey, 

                                                 byte appId, 

                                                 ref CyBtldr_CommunicationsData comm, 

                                                 CyBtldr_ProgressUpdate update); 

    } 

} 

 

6 まとめ 

ブートローダは製品の現場での改良に有益な方法です。各ブートローダはホストと通信するためにハードウェア通信インター

フェースが必要です。USBは通信インターフェースとして広範に使用可能です。 

このアプリケーション ノートおよびサンプル コード CE95391に説明された PSoC USB HIDブートローダは立ち上げと稼動に

迅速かつ信頼性のあるソリューションです。USBFSコンポーネントは HIDクラスとして設定されているため、特別なドライバー

は不要で、どのオペレーティング システムにもインターフェースできます。 

Windowsブートローダ ホスト プログラムは PSoC Creatorと共に提供されます。また、本アプリケーション ノートに、サイプレスが

提供したファイルを利用して自分の Windows ブートローダ ホストのアプリケーションを作成する方法についても説明しました。 

http://www.cypress.com/
http://www.cypress.com/documentation/code-examples/ce95391-psocr-usb-hid-bootloader


 

PSoC
®
 USB HIDブートローダ 

www.cypress.com 文書番号: 002-11097 Rev. *A 16 

7 関連リソース 

サンプル コード 

 CE95391 – USB HID Bootloader Code Example 

アプリケーション ノート 

 AN54181 – Getting Started with PSoC 3 

 AN79953 – Getting Started with PSoC 4 

 AN77759 – Getting Started With PSoC 5LP 

 AN73854 – PSoC 3, PSoC 4, and PSoC 5LP Introduction to Bootloaders 

 AN60317 – PSoC 3 and PSoC 5LP I
2
C Bootloader 

 AN86526 – PSoC 4 I
2
C Bootloader 

 AN68272 – PSoC 3, PSoC 4, and PSoC 5LP UART Bootloader 

 AN84401 – PSoC 3 and PSoC 5LP SPI Bootloader 

 AN57473 – USB HID Basics with PSoC 3 and PSoC 5LP (Fundamentals with Mouse and Joystick) 

 AN58726 – USB HID Intermediate with PSoC 3 and PSoC 5LP (with Keyboard and Composite Device)  

 AN56377 – PSoC 3 and PSoC 5LP - Introduction to Implementing USB Data Transfers 

その他の情報 

 SuiteUSB - Visual Studio用 USB開発ツール 

 EZ-USB FX3ソフトウェア開発キット 
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A 付録 A – USBFS HID コンフィギュレーション 

本節に USB ブートローダ ディスクリプタの段階的な設定方法を示します。USB コンポーネントの設定に説明した通りに、 

ブートローダ テンプレート ファイルの bootloader.root.xmlからディスクリプタをインポートできます。 

本アプリケーション ノートでは、外部で提供されるドライバー ファイルを必要としないように USB HIDクラスを使用します。 

USBFS コンポーネントを設定するために、PSoC Creator プロジェクトの回路図にあるコンポーネント シンボルをダブルク 

リックしてください。 

A.1 デバイス ディスクリプタの作成 

1. Descriptor ツリーで、Device Descriptor をクリックします。図 15に示すように、Device Attributesのオプションを設

定します: 

 Vendor ID: 0x04B4 

 Product ID: 0xB71D 

 Device Release: 0x0101 

 Manufacturing String: Cypress Semiconductor 

 Product String: PSoCx Bootloader 

図 15. USBFSデバイス ディスクリプタ 

 

ハード要求はベンダーID (VID) と製品 ID (PID) の変更だけです。使用される VID (0x04B4) はサイプレス セミコンダクタ 

社特定の VID で、この例では利用可能です。 しかし、生産向けアプリケーションを開発する時には貴社に割り当てられた

VID を使用しなければなりません。選択された PID はこのアプリケーションに一意のものです。ブートローダ ホスト  

アプリケーションはデバイスを認識するために VIDと PIDを使用します。 

製品文字列や製造文字列などの文字列を自由に変更することができます。 

http://www.cypress.com/


 

PSoC
®
 USB HIDブートローダ 

www.cypress.com 文書番号: 002-11097 Rev. *A 18 

2. String Descriptor ツリーから、Add Stringをクリックします。図 16に示すように、文字列を追加します: 

図 16. String Descriptors 

 

3. Device Descriptorツリーで、Configuration Descriptorをクリックします。Configuration Attributesのオプションを

図 17に示すように設定してください： 

図 17. USBFSコンフィギュレーション ディスクリプタ 

 

このステップでの主な設定は、バスにより給電されるように USBデバイスを定義し、ホストから 20mAの消費電力を要求

することです。アプリケーションに 20mA未満を供給できますが、この要件を超えてはいけません。  

Remote Wakeup機能は必要ないため無効 (disabled) にします。 

http://www.cypress.com/


 

PSoC
®
 USB HIDブートローダ 

www.cypress.com 文書番号: 002-11097 Rev. *A 19 

4. Interface Descriptor ツリーで、Alternate Setting 0をクリックします。Interface Attributesを図 18に示すように設

定してください: 

 Interface String: PSoCx Bootloader 

 Class: HID 

 Subclass: No subclass 

図 18. USBFS Alternate Setting 

 

各インターフェースは、複数のエンドポイント コンフィギュレーションのために、複数の代替設定を持つことができます。 

ここでは、代替設定が 1つのみ必要です (デフォルト)。 

ここでデバイスが HID クラスに準拠することを指定します。Class を Undefined から HID に変更すると、Descriptor 

Rootツリーで「HID Class Descriptor」という追加ディスクリプタが出現します。 

HID レポートをまだ設定していないことにご注意ください。この時、OKまたは Applyボタンをクリックすると、HID レポート

が定義されていないため、エラー メッセージが出ます。このレポートの作成は次に説明します。 

http://www.cypress.com/
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5. Add Endpoint ボタンをクリックしてください。図 19 に示すように、Alternate Setting 0 ツリーで追加の Endpoint 

Descriptorが出ます。 

図 19. USBFSエンドポイントの追加 

 

http://www.cypress.com/
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A.2 HID Descriptorの作成 

1. 図 20に示すように、HIDレポート ディスクリプタを作成するために HID Descriptorインターフェースを使用します： 

図 20. HIDディスクリプタ 

Step 1

Step 2
Step 3

Step 4

Step 5

 

1. HID Descriptor タブをクリックします。 

2. Add Reportボタンをクリックします。 

ステップ 3 からステップ 5 については、22 ページの表 1 をご参照ください。レポート項目は、表に示す順序で追加する 

必要があります。 

3. HID Item Listから一つの項目を選択します。  

4. 表に示すように、Item Value リストから一つの値を選択します。 

5. Item Value ボックスが特定の選択済み項目にテキスト フィールドを含む場合、10 進数または 16 進数のラジオ  

オプションをクリックして、フィールドに必要な値を入力します。 

6. レポート ディスクリプタが 22ページの図 21のスクリーンショット画像のようになるまで、ステップ 3からステップ 5を

繰り返します。 

7. HIDディスクリプション名を「Generic HID」に変更します。 

http://www.cypress.com/
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表 1．HIDディスクリプタ項目 

HID Item Item Value (USAGE) 

USAGE PAGE (05) Generic Desktop Controls 0x01 

USAGE (09) Undefined 0x00 

COLLECTION (A1) Physical 0x00 

USAGE (09) Undefined 0x00 

COLLECTION (A1) Physical 0x00 

USAGE (09) Undefined 0x00 

LOGICAL_MINIMUM (15) 0x00 

LOGICAL_MAXIMUM (25) 0xFF 

REPORT_SIZE (75) 0x08 

REPORT_COUNT (95) 0x40 

OUTPUT (91) Bit 1 – Variable 

USAGE (09) Undefined 0x00 

LOGICAL_MINIMUM (15) 0x00 

LOGICAL_MAXIMUM (25) 0xFF 

REPORT_SIZE (75) 0x08 

REPORT_COUNT (95) 0x40 

INPUT (81) Bit 1 – Variable 

END_COLLECTION (C0) NA 

END_COLLECTION (C0) NA 

 

図 21. 完成した HIDディスクリプタ 

 

http://www.cypress.com/
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2. Device Descriptor タブをクリックします。Descriptor ツリーで、HID クラス ディスクリプタをクリックします。図 22 に示す 

ように、Device Attributesのオプションを設定します: 

 Descriptor Type: Report 

 Country Code: Not Supported 

 HID Report: Generic HID 

図 22. USBFS HIDデバイス属性 

 

プロジェクトはレポート ディスクリプタを使用するため、ディスクリプタの種類を「Report」に設定します。 

プロジェクトは特定の国で使用するものではないので、国コードを「Not Supported」にします。 

最後に、HID クラス ディスクリプタは、前のステップで作成した HID レポート ディスクリプタを指す必要があります。この 

リンクを作るために、HIDレポートを HIDレポート ディスクリプタ (この例では Generic HID) に一致させます。 

http://www.cypress.com/
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3. Descriptor ツリーで、最初の Endpoint Descriptor エントリをクリックします。図 23 に示すように、Endpoint 

Attributesのオプションを設定します: 

 Endpoint Number: EP1  

 Diretion: OUT 

 Transfer Type: INT  

 Interval: 10  

 Max Packet Size: 64 

図 23. USBFSエンドポイント 1 

 

最初のエンドポイント (EP) は OUT エンドポイントとして使用されます。ホストから受信したデータのバッファの役割をします。

USB IN (入力) と OUT (出力) の方向は、常に USBホストから見た向きになります。 

先ず、このエンドポイントをエンドポイント 1 (EP1) として定義します。次に、エンドポイントの方向を OUTに設定します。 

アプリケーションが HIDのため、割り込み (INT) 転送を使用する必要があります。 

http://www.cypress.com/
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4. EP2 はホストに送信されるデータのバッファとして機能します。次のエンドポイントに対しても前述のステップを繰り返し、

それを INエンドポイントとして次の属性があるように設定します (図 24を参照)： 

 Endpoint Number: EP2 

 Direction: IN 

 Transfer type: INT  

 Interval: 10  

 Max Packet Size: 64 

図 24. USBFSエンドポイント 2  

 

5. Applyボタンをクリックしてから OKボタンをクリックし、コンフィギュレーション ウィザードを閉じます。 

http://www.cypress.com/
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B 付録 B – ブートローダとデバイス リセット 

このアプリケーション ノートで述べたように、ブートローダとブートローダブル間の制御の遷移は常にデバイス リセットで行わ

れます。システムが極めて重要な機能を実行しながら、他のプログラムに変更する場合には、このことを考慮しなければなり

ません。このセクションでは、リセットを使用しなければならない理由、およびアプリケーションのデバイス性能に影響を与える

ことなど、詳細に説明します。 

B.1 なぜデバイス リセットが必要なのか？ 

デバイス リセットが必要とされる理由を理解するために、システムのブートローダ  プロジェクトおよびブートローダブル  

プロジェクトのいずれも完全な自己完結型 PSoC Creator プロジェクトであることに注意する必要があります。各プロジェクト

は固有のデバイス コンフィギュレーション設計を有します。そのため、一つのプロジェクトから他のプロジェクトに変更する際に

は全ての PSoCデバイスのハードウェア機能を再定義することができます。 

複雑なカスタム機能を実装するために、デバイス コンフィギュレーションで数千の PSoC レジスタ設定が行われます。特に、

PSoC のデジタルとアナログ ルーティング機能に当てはまります。レジスタとルーティングを設定する時、新しいコンフィギュ 

レーション用にビットを設定する他、古いコンフィギュレーションのビットをリセットすることを確認しなければなりません。そうし

ないと、新しいコンフィギュレーションは動作しなくなり、デバイスを破壊する可能性さえあります。 

そのため、ブートローダとブートローダブル プロジェクトの間で変更するとき、デバイス ソフトウェア リセット (SRES) を行いま

す。これにより、全ての PSoC レジスタはデフォルト状態にリセットされます。そして、新しいプロジェクトのコンフィギュレー 

ションを開始することができます。すべての PSoC レジスタはそのデバイスのリセットのデフォルト状態に初期化されると想定

すると、コンフィギュレーション時間とフラッシュ メモリ使用量の両方を低減できます。 

B.2 PSoC 3および PSoC 5LPデバイスの I/Oピンへの影響 

アプリケーション ノート「AN61290, PSoC 3, PSoC 5LP Hardware Design Considerations」 、および「AN60616, PSoC 3 

and PSoC 5LP Startup Procedure」で説明した通りに、リセットおよび起動プロセスの実行時に PSoC 3と PSoC 5LPの

I/Oピンは表 2に示すように、3種類の駆動モードで動作します。PSoC 4 Lシリーズの I/Oピンも同様です。 

表 2. デバイス リセット中の PSoC 3および PSoC 5LP I/Oピンの駆動モード 

起動イベント I/Oピンの駆動モード 

期間 (標準値) 

コメント 
低速 IMO 

(12MHz) 

高速 IMO 

(48MHz) 

デバイス リセット (SRES) が

アクティブ 

HI-Zアナログ 40µs リセットがアクティブの間、I/Oが

HI-Zアナログ モードに保持される 

デバイス リセットが解除される 

不揮発性ラッチ (NVL) が I/O

ポートにコピーされる 

NVL設定: 

HI-Zアナログ、プルアップま

たはプルダウン 

約 12ms 約 4ms 期間はコード実行速度およびコン

フィギュレーションの複雑度に左

右される 
コードの実行が開始 

I/O ポートおよびピンは設定さ

れる 

PSoC Creatorプロジェクトの

コンフィギュレーション 

該当なし 8つの可能な駆動モード。詳細に

ついては、デバイス データシート

をご参照ください 

コードは main() に到達 コードは I/Oピンの機能を変

更可能 

該当なし  

 

PSoC 3および PSoC 5LPでの NVL使用の詳細についてはデバイスのデータシートをご参照ください。PSoC Creatorプロジェクト

では、NVLは 2箇所で設定されます。 

 I/Oポート用の Reset タブ、個別のピン コンポーネントのコンフィギュレーション 

 他のすべての NVL用には System タブ、デザイン全体リソースのウィンドウ (DWR) 

http://www.cypress.com/
http://www.cypress.com/go/an61290
http://www.cypress.com/go/an61290
http://www.cypress.com/go/an61290
http://www.cypress.com/go/an60616
http://www.cypress.com/go/an60616
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デバイスがプロジェクトをプログラムされる時、NVLが更新されます。ブートローダブル プロジェクトで NVL をセットすることが

できない点に注意してください。その DWRの設定は関連するブートローダ プロジェクトのと一致する必要があります。 

最終 I/O駆動モードは個別のピン コンポーネントのコンフィギュレーションでセットします。 

図 25 に、デバイスの起動およびコンフィギュレーション用のタイミング図を示します。図の中央にある例は PSoC 3 用のもの

です。PSoC 4 L シリーズおよび PSoC 5LP には同様のプロセスが適用されます。詳細については、AN60616 - PSoC 3 

and PSoC 5LP Startup Procedureをご参照ください。 

図 25. デバイスの起動プロセス図 

Reset Released

Reset Boot

Hardware Startup Firmware Startup

CPU halted
CPU Specific 

Source File
Main.c ...

CyFitter_cfg.c

 

No CPU 

execution

Hardware Startup Firmware Startup

KeilStart.A51 Main.c ...

CyFitter_cfg.c

Configure 

Debug, 

Bootloader
Clear SRAM

Clear 

IDATA
DMAC 

configuration

...

...

 

CyFitter_cfg.c

Register 

initialization

DSI config, 

Digital routing

Digital array, 

ClockSetup()

Analog set 

default

 

B.3 他の機能への影響 

デバイス リセットの時に、汎用デジタル ブロック (UDB) レジスタはリセットされたため、全ての UDB ベースのコンポーネント

がなくなり、その機能が停止されます。同様なことは PSoC 3 および PSoC 5LP のコンフィギュレーション可能な SC/CT 

ブロック、および PSoC 4 Lシリーズの CTBmブロックに基づいたアナログ コンポーネントにも当てはまります。 

すべての固定ペリフェラル  (デジタルおよびアナログ ペリフェラル) がそのアイドル状態にリセットされます。これは、DMA、

DFB、タイマー (TCPWM)、I
2
C、USB、CAN、ADC、DAC、コンパレータ、およびオペアンプを含みます。IMO以外の全てのク

ロックは停止します。 

すべてのデジタルおよびアナログ ルーティング制御レジスタがリセットされます。これにより、すべてのデジタルおよびアナロ

グ スイッチが開いて、デバイス内のすべての接続を切ります。これは NVL以外のすべての I/Oとの接続を含みます。 

すべてのハードウェア ベースの機能はコンフィギュレーション後に復元されます。(図 25 を参照) プロジェクトの main() 関数

の実行を開始する時、すべてのファームウェアの機能が復元されます。 

 

http://www.cypress.com/
http://www.cypress.com/go/an60616
http://www.cypress.com/go/an60616
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B.4 例: ファン制御 

ブートローダおよび関連するデバイス リセットをファン制御などの代表的な用途内に統合する方法を検証してみましょう。

PSoC Creator は PWM、タコメーター入力キャプチャ タイマー、制御レジスタ、ステータス レジスタ、DMA チャネルまたは割

り込みなどの必要なハードウェア ブロックをすべて含むファン コントローラー コンポーネントを提供します。詳細については、

ファン コントローラー アプリケーションのウェブ ページをご参照ください。 

ファン制御アプリケーションはブートローダブル プロジェクトにあります。オプションで、ブートローダはブートロード中にファン

の動作を維持するためにカスタマイズされることができます。 

表 3 に示す通りに、ファンはデバイスがリセットしている間、ブートローダとブートローダブル間の転送中に動作し続けることが

できます。 

表 3. ファン コントローラー用のデバイス リセット中の PSoC I/Oピンの駆動モード 

I/Oピンの駆動モード コメント 

HI-Zアナログ オプションで、100%デューティ比のために、PWM ピンに外部プルアップまたはプルダウン抵抗

を追加。ファンは慣性によって回り続ける可能性があるため、これは不要とされる 

NVL設定:HI-Zアナログ、 

プルアップまたはプルダウン 

オプションで、100%デューティ比のために、PWM ピン コンポーネントのリセット値をプルアップ

またはプルダウンに設定。ファンは慣性によって回り続ける可能性があるため、これは不要とさ

れる 

PSoC Creatorのプロジェクト

のコンフィギュレーション 

100%デューティ比のために、PWM ピン コンポーネントの駆動モードおよび初期状態を設定。 

PWMコンポーネントはアクティブになるが、動作しない 

Main() の実行を開始 PWM_Start() を呼び出す時、PWMはコンポーネントのデフォルトのデューティ比で PWMピン

の駆動を開始。 

ファームウェアはタコメーターのデータを読み出し、デューティ比の制御を積極的に開始 
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C 付録 C – ホスト コア API 

 cybtldr_api2.c / .h 

これは、ブートロード動作全体を処理する、より高いレベルの API です。ファイルを開閉する関数があります。これはブート 

ロード動作のために、cybtldr_api.c / .h APIの関数を呼び出します。この APIは GUIベースのブートローダ ホストをビルドする時

に使用されます。  

 cybtldr_api.c / .h 

これは 1回に 1つのデータ列をブートローダのターゲットに送信する低レベル APIファイルです。ブートロード動作の設定、列

のプログラム、列の消去、列のベリファイ、およびブートロード動作の終了を行う関数が含まれています。表 4は、この APIの

関数の詳細を説明します。 

表 4.cybtldr_api.c /.h の関数 

関数 説明 

CyBtldr_StartBootloadOperation  通信インターフェースを有効にし、「ブートロード開始」コマンドをターゲットに送信します。 

 受信された応答パケットから、ターゲット デバイスのシリコン ID、シリコン リビジョンおよび

ブートローダのバージョンを確認します。 

CyBtldr_ProgramRow  最初に列を確認します。つまり、ターゲットフラッシュの特定のアレイ ID のために、Get 

Flash Size コマンドをターゲットに送信します。これに応えて、ターゲットはそのアレイに

あるブートローダブルのフラッシュ部の開始と終了の列番号を返します。ホストはこの応答

を読み出し、指定した列がフラッシュのブートローダブルの領域にあるかどうか確認します。 

 列の確認が成功したら、ホストは列データをより細かい部分に分割して、Send data 

コマンドでターゲットに送信します。 

 列データの最終部と共に、Program Rowコマンドをターゲットに送信します。 

CyBtldr_VerifyRow  この関数は最初に特定のアレイ IDと列番号のために列を確認します。 

 列の確認が成功したら、確認されたフラッシュ列の Verify Row コマンドを送信します。 

このコマンドの応答で、ターゲットは列のチェックサムを返します。 

 返されたチェックサムは期待されるチェックサム値と比較されます。 

CyBtldr_EraseRow  この関数も最初に特定のアレイ IDと列番号のために列を確認します。 

 列の確認が成功したら、確認されたフラッシュ列の Erase Rowコマンドを送信します。 

CyBtldr_EndBootloadOperation Exit Bootloadコマンドを送信し、通信インターフェースを無効化します。 

 

 cybtldr_command.c / .h 

この APIは、ターゲットへのコマンド パケットの構成を処理し、ターゲットから受信した応答パケットを解析します。cybtldr_api.c / .h

は、この APIの関数を呼び出します。例えば、Enter Bootloadコマンドを送信するために、CyBtldr_StartBootloadOperation() は、

この API の CyBtldr_CreateEnterBootloadCmd() 関数を呼び出します。また、ターゲットに送信する前に、コマンド パケット

のチェックサムを計算する関数もあります。 

 cybtldr_parse.c / .h 

このモジュールは、デバイスに送信するブートローダブルのイメージを含む.cyacd ファイルの構文解析を行います。ファイルへの 

アクセス設定、ヘッダの読み出し、列のデータの読み出し、およびファイルを閉じるための関数も持っています。 

 cybtldr_utils.h 

このヘッダはブートローダのバージョン情報、およびステータスおよびエラーの定数を提供します。  
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